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WaspTime Getting Started 

Congratulations on your purchase of the WaspTime 7 Software!  This complete Time Tracking 
solution contains everything you need to quickly and accurately track employee time.  This 
latest innovation from Wasp Technologies takes the popular WaspTime Time and Attendance 
package and expands on it.   
  
This powerful time management solution includes: 
  
WaspTime - WaspTime tracks your employees' time and provides a daily reconciliation of time 
records. This data can later be exported into your payroll software system and can also be used 
to generate various management reports. This application also allows you to setup all of the 
clocks with which WaspTime will communicate.  You can maintain your clocks, download 
punches and even maintain fingerprint records for your bioclocks. 
  
PCPunch - This "time clock emulation" software allows you to turn any user's PC into a virtual 
time clock!  Your employees can punch in from their individual workstations, or you can setup a 
central workstation for all employees to use.  This information feeds right back into WaspTime 
so you can keep track of your employees' hours and even send that information to your payroll 
processor!  You get all of this functionality without having to use a time clock. 
  
This guide will take you through the steps to setup all the hardware and software needed to run 
the WaspTime Software Suite.  As several different clocks were offered with this system, skip to 
the section of this guide that references the type of clock you purchased. 
  
This document is broken into the following sections: 
  
Step 1 - Connect Your Clocks 
Step 2 - Install the Software Suite 
Step 3 - Setup WaspTime 
Step 4 - Setup Clocks 
Installation Setup Scenarios 

 

Step 1 - Connect Your Clocks: 

There are several types of clocks you can purchase to use with the WaspTime applications.  This Quick 
Start Guide describes the steps for installing and setting up each of the clock types.  Please refer to the 
instructions that pertain to your clock type. If you are unsure of which type of clock you have, look at the 
label on the back of the clock. 
 
The available clock types are: 
  
BC100, RF200, HD300 
1100, 2100, 3100 Setup 
B2000 
B1000 or B1100 
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BC100, RF200, HD300 Setup 

Complete these steps to connect one or more clocks to your database. 
  

1. Use the included BC100/RF200/HD300 Clock Wall Mounting Instructions to attach the 
mounting bracket to the wall. 

2. Wasp provides two cables with your clock. One is a crossover cable. Use the crossover cable 
only if connecting your clock directly to your PC instead of through a hub or router. The other 
cable is a regular network cable and can be used between the clock and any Ethernet port. 
 
Plug the network cable into the back of the clock, or optionally, plug the RS232 into the 
appropriate wiring terminal in the back of the clock. 

3. Plug the power cable into the clock and then into the wall. 
 
NOTE: If you are using the optional Power Over Ethernet option DO NOT plug the power cable 
into the clock. (Power Over Ethernet option is sold separately.) 

4. Finish mounting the clock to the wall using the BC100/RF200/HD300 Clock Wall Mounting 
Instructions. 

5. When the clock is powered on, you will hear a beep and the clock will display the time. If the 
time is not correct, you will be able to set it to the correct time later using the WaspTime 
application. 

  
 

1100, 2100, 3100 Setup 

  
Complete these steps to connect one or more WaspTime Clocks to your database. 
  

1. Use the included 1100/2100/3100 Clock Wall Mounting Instructions to attach the clock to the wall. 
  

2. Plug a RJ-45 CAT 5 cable that is connected to your Ethernet network into the plug on the bottom 
of the clock. 
 
Wasp provides two cables with your clock. One is a crossover cable. Use the crossover cable 
only if connecting your clock directly to your PC instead of through a hub or router. The other 
cable is a regular network cable and can be used between the clock and any Ethernet port. 
  

3. Plug the power cable into the clock and then into the wall. 
  

NOTE: If you are using the optional Power Over Ethernet option DO NOT plug the power cable 
into the clock. (Power Over Ethernet option is sold separately). 
  
When the clock is powered on, you will hear a beep and the clock will display the time. If the time 
is not correct, you will be able to set it to the correct time later using the WaspTime application. 
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B2000 Setup 

Complete the steps below to connect one or more B2000 clocks to your database. 
  

1. Use the included B2000 Clock Wall Mounting Instructions to attach the clock to the wall. 
  

2. Connect the power cable to the clock. 
  

3. Connect the power cable to a 12V 50Hz AC power source. 
4. Plug the network cable into the back of the clock, or optionally. 
5. Finish mounting the clock to the wall using the B2000 Clock Wall Mounting Instructions. 
6. When the clock is powered on, you will hear a beep and the clock will display the time. If the time 

is not correct, you will be able to set it to the correct time later using the WaspTime application. 
  

 

B1000 or B1100 Setup  

Complete the steps below to connect one or more WaspBio Clocks to your database. 
  

1. Use the included B1000/B1100 Clock Wall Mounting Instructions to attach the clock to the wall. 
  

2. Connect the power cable to the WaspBio terminal. 
  

3. Connect the power cable to a 12V 50Hz AC power source. 
  

4. The WaspBio Clock can be connected to a computer using a RJ-45 CAT 5 cable.   
 
Plug the RJ-45 CAT 5 cable that is connected to your Ethernet network into the plug on the 
bottom of the WaspBio clock.  Wait for the power on screens to cycle through to the startup 
display.  The screen will look similar to the following: 
 

 
  

5. Press the [Menu] key on the WaspBio Terminal Keyboard.   The Menu screen appears. 
 
  

6. Use the down arrow key on the WaspBio Terminal Keyboard to highlight Options, then press 
[OK].   
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The Options screen appears. 
  

7. Use the down arrow key on the WaspBio Terminal Keyboard to highlight Comm Opt, then press 
[OK]. 
 

 
 
The Comm Opt screen appears. 
  

8. The Comm Opt screen displays the settings for configuring your Ethernet connection.  DHCP 
should be set to No. 
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Set the fields on this screen to the following settings. 
  

Field Setting 
Baud Rate Leave at the default setting (1115200). 
Device Number This is the machine ID number.  The range is 1 to 255. 

 The default is 1.  This number is recognized by the 
software. 

IP Address This field defaults to 192.168.0.0 and will need to be 
changed for the current network IP. (see Net Mask 
below for further instructions) 

Net Speed Leave at the default setting (Auto). 
Net Mask This should match the net mask on your computer 

where you have the WaspTime Service installed. 
  
To determine the net mask: 

1. On the computer where you installed the 
software, select Start > Run. 
  

2. Type cmd in the Open field, then click the OK 
button.  The Command prompt screen appears. 
  

3. On the Command prompt screen, type 
ipconfig.  Your computer's settings will appear. 
 A listing for Subnet Mask will appear.   
 
Example: If your Subnet Mask is 255.255.0.0 
and the IP Address shown on the ipconfig 
screen is 192.168.0.1, you should set your 
clocks IP Address to 192.168.xxx.xxx where the 
last two sets of numbers are any numbers of 
your choosing between 1 and 254.  Do not use 
an IP address that is already in use (you can 
ping the IP to determine if it is already being 
used). 

Gateway This needs to be set to your computer's gateway 
address.  To determine the address, follow the steps 
described for Net Mask, above.  In the ipconfig 
information there is a listing for Default Gateway.  Enter 
this number in the Gateway field. 

RS232 Set to Yes 
RS485 Set to No 

9. By default your WaspBio clock time format is set to yy-mm-dd.  You can change this format by 
following the steps below:  
 
 

a. Press the [Menu] button on the WaspBio Terminal Keyboard.  The Menu screen 
appears. 
  

b. Use the down arrow key to select Options,  then press the [OK] button.  The Options 
screen appears. 
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c. Use the down arrow key to select System Options, then press the [OK] button.  The 
System Options screen appears. 
  

d. Use the down arrow key to select Fmt, then press the [OK] button. 
  

e. Use the up or down arrow button to change the date format. 
  

10. Set your clock to the correct date and time by following the steps below: 
  

a. Press the [Menu] button on the WaspBio Terminal Keyboard.  The Menu screen 
appears. 
  

b. Use the down arrow key to select Options, then press the [OK] button.  The Options 
screen appears. 
  

c. Use the down arrow key to select System Options, then press the [OK] button.  The 
System Options screen appears. 
  

d. Use the down arrow key to select Date Time, then press the [OK] button. 
  

e. Scroll to the year, month, date, hour, minutes or seconds fields using the keys.  To 
modify the selected field, press the [OK] button and type in a new value using the number 
keys on the WaspBio Terminal Keyboard. 
  

   
  

 

Step 2 - Install the Software: 

  
1. First choose the PC on which you want to install the WaspTime database. We recommend that 

the machine on which you install the WaspTime database and service be a server or machine 
that is always up and running.  This prevents problems with receiving automatic punch downloads 
due to the server or machine not being turned on. 
  

2. Insert the WaspTime Installation disk into your CD-ROM drive.  The message screen shown 
below appears: 
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Click Yes after you have turned off your virus software and spam filters.  You cannot proceed with 
the installation until these items are disabled.  You can turn them back on once the installation is 
complete. 
  

3. After you click Yes, the Welcome screen appears. 
 

 
  
 Click Next on this screen. 
  

4. The Customer Information screen appears next.  Enter your User Name (this can be any name 
of your choice), your Company Name and the Serial Number.  The serial number can be found 
on or in the DVD case containing your WaspTime software. 
 

 
Click the Next button to continue. 
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5. Click the link to view the Quick Start Guide or to view a .pdf version of the online help.  If you do 
not have the Acrobat PDF Viewer installed, you will need to install it to view this document.  The 
Acrobat PDF Viewer can be downloaded for free from the Adobe website. 
 

 
 
Click the Next button to continue. 
  

6. Review the license agreement, then click I accept the terms of the license agreement.  Click 
the Next button to continue.  You will not be able to continue installing the application until you 
click the I accept the terms of the license agreement option. 
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7. The next screen lists the default Destination Folder for installation of WaspTime (C:\Program 
Files\Wasp Technologies\WaspTime).  You can select a new destination by clicking the Browse 
button and navigating to a new folder, or accept the default location by clicking the Next button. 
 

 
  

8. The Select Features screen displays all features available for installation.  Select which features 
you want to install on this machine. By default, only WaspTime Client is selected.  When you 
select an item, a detailed description of that item appears on the right side of the screen. 
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If you are in doubt as to where and when to install a feature, use the information below as a 
guide: 
  
• Time Server- This feature should only be installed one time on one machine.   This is 

because all of the WaspTime features (PCPunch, etc.) run off of the same time server.  All of 
the instances of the WaspTime client and PCPunch you install will connect to this time 
server. 
  

• Database - This feature should only be installed one time on one machine.   This is because 
all of the WaspTime features (PCPunch, etc.) run off of the same database.  All of the 
instances of the WaspTime client and PCPunch you install will connect to this database. 
  

• WaspTime Client - This application can be installed on any machine where you want to 
maintain employees and clocks.  For WaspTime, this is usually the payroll administrator's 
machine.  Only one user will be allowed to login at a time. 
  

• PCPunch - You will want to install PCPunch on all machines where users will need to punch 
in and out.  This may be at a central PC if multiple employees will be punching in and out 
from one location.  Or this may be on your employees' individual workstations.   
 
Note:  If you purchased the WaspTime Web tool, you should install and use it instead of 
PCPunch. 

12. For new installs, or if the WaspTime installer does not detect an existing database, the following 
screen will appear: 
 
 

 
 
If you are installing WaspTime for the first time, select Yes.  Click No if you are migrating from an 
older version of WaspTime (WaspTime 6, for example).  The installer will convert your database 
to the correct version.   
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13. Next a screen appears listing all settings you have entered.  Review this information carefully.  If 
you want to change any of this information, click the Back button to return to the screen where 
you initially entered the information.  If you are ready to begin copying the files to your computer, 
click Next. 
 

 
  

14. Next a series of status screens will appear letting you know that the system is installing the 
programs.  If you need to stop the installation at this point, click the Cancel button. 
 

 
 
This may take a few minutes, please be patient. 
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15. The ReadMe documentation will appear.  Review this screen for the latest information regarding 
setup, compatibility and features.  Close the ReadMe screen. 
  

16. That's it!  You have installed the Software Suite successfully.  Click Yes on the Wizard Complete 
screen, then click Finish to restart the computer now.  Click No, then click Finish to restart the 
computer later.  Remove the installation disk prior to restarting your computer. 
 
  

 

Step 3 - Setup WaspTime 

WaspTime can be accessed from Start > Program > Wasp Technologies > WaspTime > WaspTime.   
  

1. Activate WaspTime - The first time you access WaspTime after installation, a screen will 
appear prompting you to enter an Activation Key.  You can use the system for 30 days 
without entering an activation key by clicking the Activate Later button.  After 30 days, 
however, you MUST activate the product to continue using it. 
  

a. Click the link on the Activation screen 
(http://www.waspbarcode.com/register/register.asp).   
 

 
 
You will be directed to the Wasp Registration Website.   
  

b. You can use the product without Activation for a period of 30 days, by clicking the 
Activate Later button, however it is recommended that you activate immediately 
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to ensure continued access to the system. 
  

c. Enter your address information in the fields provided on the Registration Website. 
 You should copy and paste your serial number into the Serial Number field to 
make sure you enter the correct number. 
  

d. An email containing your Activation Code will be sent to the email address you 
entered on the Registration Website. 
  

e. When you receive the Activation Code, enter it into the Activation Key field, then 
click the Activate Now button. 
 

was 
  

A message will appear stating you have successfully activated the application.   
  

2. Run the WaspTime Setup Wizard - The wizard automatically starts the first time you 
access WaspTime.  If it does not, select Launch Setup Assistant from the File Menu. 
This document contains a brief overview of the System Setup screens.  Detailed 
instructions on completing the Setup Wizard are included in the WaspTime Help file. 
 Select the Help menu from the top of any WaspTime screen or press the [F1] key to 
access this information. 
  

3. Wizard Step 1: Company Information 
 
Enter your company name, address, etc. 
  

4. Wizard Step 2: Options 
 
The Options tab allows you to setup a punch interval, select to use military time within the 
application, view or modify your server location and/or designate a location for your 
backup file.  This is also where you can enter your email settings so you can receive 
reports and alerts via email. 
  

5. Wizard Step 3: Departments 
 
Add an entry for each department in your company. Departments are used to filter 
reports and lists. Filtering helps reduce the time required by the system to build your 
report. 
  

6. Wizard Step 4: Payroll Codes 
 
On this screen of the Setup Wizard, you can modify the Payroll Settings to match the way 
your business works. 
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7. Wizard Step 5: Absences 
 
Enter codes here that you can later assign to employee absences on the Timecard 
screen to tell the system how to calculate pay for those absences.  For instance, you can 
set up some absences to be included in overtime calculations and others not to be 
included in these calculations. 
  

8. Wizard Step 6: Statutory Holidays 
 
This screen allows you to enter paid holidays that you can be applied to employees 
timecards via Utilities>Process Holidays. 
  

 

Step 4 - Setup Clocks in WaspTime: 

  
Next you can go to the Clock Setup screen in WaspTime to add your clocks.  Please refer to the 
Getting Started section in the WaspTime application for detailed information on adding clocks. You 
have the option to let the system automatically detect your clocks so you don't have to enter them 
manually.  
 
Note: All clocks must be on the same segment as the computer that is trying to recognize them for 
setup. After the initial setup and setting of the IP address the clock can be moved to a different 
segment. 

 

Installation Setup Scenarios: 

  
There are several ways you can configure your server and client machines.  The flowcharts provided 
below give you a visual outline of the most frequently used configurations. 
  
Scenario 1 - 
  
This is the most common configuration. 
  

 
  
In this scenario, the WaspTime Server, Database and Client are all installed on one machine.  WaspTime 
Web is installed on another machine (WaspTime Web must be installed on a machine with IIS). 
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Scenario 2 - 
  

 
  
In this scenario, the WaspTime Server and Database are installed on machine 1, the Client is installed on 
machine 2 and the WaspTime Web is installed on machine 3. 
  
Scenario 3 - 
  

 
  
In this scenario, the WaspTime Server is installed on machine 1, the Database is installed on machine 2, 
the Client is installed on machine 3 and WaspTime Web is installed on machine 4. 
  
Multiple Clients - 
  
Keep in mind that you can install the Client on multiple machines, if needed.  Below is example of the 
WaspTime Server and Database installed on one machine, and the Client installed on multiple machines: 
  

 
  

 
  

  
 


	WaspTime Getting Started
	Step 1 - Connect Your Clocks:
	BC100, RF200, HD300 Setup
	1100, 2100, 3100 Setup
	B2000 Setup
	B1000 or B1100 Setup

	Step 2 - Install the Software:
	Step 3 - Setup WaspTime
	Step 4 - Setup Clocks in WaspTime:
	Installation Setup Scenarios:


